
ภาคผนวก ก. 

วธิีการเขียนโปรแกรมโดยใช้ Program Arduino 

 

1. เปิดโปรแกรม Arduino ที่ได้โหลดมาจาก  http://arduino.cc/en/Main/Software 

 
2. เมื่อเปิดโปรแกรมแลว้จะพบกับหนา้ต่างของ IDE ดังรูป 

 
 

3. ไปที ่Tools->Board แล้วเลือกให้ตรงกับบอร์ดที่ใชง้าน ส าหรับ  Arduino UNO R3 ให้เลือก

บอร์ด Arduino UNO 

 

 

4. เขียนโปรแกรมดังขอ้ความด้านล่างนี้ 

http://arduino.cc/en/Main/Software
http://www.ec.in.th/index.php?route=product/product&product_id=1002
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/* 

  Arduino "Hello world" 

    

  This example code is in www.EC.in.th. 

  */ 

  

// the setup routine runs once when you press reset: 

void setup() { 

   // initialize serial communication at 9600 bits per second: 

   Serial.begin(9600); 

} 

  

// the loop routine runs over and over again forever: 

void loop() { 

  

   // print out the value you read: 

   Serial.print("Hello World\n\r"); 

} 

5. จากนั้นคอมไฟล์โปรแกรมโดยไปที่ Sketch->Verify / Compile 

http://www.ec.in.th/


 
 

6. เมื่อคอมไฟล์เรียบร้อยจะมีขอ้ความปรากฎดังรูป 



 
7. ต่อบอร์ด Arduino UNO R3 เข้ากับคอมพิวเตอร์ผ่านทางพอรต์ USB 

 
8. จากนั้นให้ไปที่ Tools->Serial Port และเลือกใหต้รงกับบอร์ด Arduino UNO ที่ใชง้าน (ส าหรับบอร์ด 

Arduino UNO R3 โปรแกรมจะเลือกใหอ้ัตโนมัติ) 

http://www.ec.in.th/index.php?route=product/product&product_id=1002


 
9. โหลดโปรแกรมเข้าบอร์ด Arduino UNO โดยไปที่ File->Upload 

 
10. จากนั้นเปิด Serial Monitor ของ Arduino IDE โดยไปที่ Tools->Serial Monitor 



 
11. เมื่อเปิด Serial Monitor จะได้ขอ้ความดังรูป 

 
  

 

 

 



ภาคผนวก ข. 

Code ของโปรแกรมที่ใช้ควบคุมเครื่องวัดปริมาณแอลกอฮอล์จากลมหายใจ  

 

#include <LiquidCrystal.h> 

/* 

 * LCD RS pin to digital pin 6 

 * LCD RW pin to digital pin 7 

 * LCD Enable pin to digital pin 8 

 * LCD D4 pin to digital pin 9 

 * LCD D5 pin to digital pin 10 

 * LCD D6 pin to digital pin 11 

 * LCD D7 pin to digital pin 12 

 * 10K resistor: 

 * ends to +5V and ground 

 * wiper to LCD VO pin (pin 3) 

 */ 

LiquidCrystal lcd(6, 7, 8, 9, 10, 11, 12); 

 

int backLight = 13;    // pin 13 will control the backlight 

// These constants won't change.  They're used to give names 

// to the pins used: 

const int analogInPin = A0;  // Analog input pin that the potentiometer is attached to 

const int analogOutPin = 9; // Analog output pin that the LED is attached to 

int sensorValue = 0;        // value read from the pot 

float outputValue = 0;        // value output to the PWM (analog out) 

float average = 0; 

void setup() { 

  // initialize serial communications at 9600 bps: 

  Serial.begin(9600); 

  pinMode(backLight, OUTPUT); 

  digitalWrite(backLight, LOW); // turn backlight on. Replace 'HIGH' with 'LOW' to turn it off. 

  lcd.begin(16,2);              // columns, rows.  use 16,2 for a 16x2 LCD, etc. 



  lcd.clear();                  // start with a blank screen 

  analogReference(DEFAULT);     // set analog reference 

} 

void loop() { 

int Oldval1; 

int sensorValue; 

int cx=0; 

int check = 2; 

float Multiply; 

float Stepzero = 0;  

float Stepten = 0;  

float Steptwenty = 0;  

float Stepthirty = 0; 

float Stepfourty = 0; 

float Stepfifty = 0; 

float Stepseventyfive = 0; 

float Stephundred = 0; 

int vTop = 0; 

int vBottom = 0; 

int Oldminbase; 

int Oldmaxbase; 

int Cnx= 0; 

int Vmax = 0; 

int Minbase = 0; 

int Maxbase = 0; 

int Vmin = 0; 

int Endcx = 0; 

int Distime = 0; 

int Y; 

int Vtop; 

 float Vz1; 

float Vt1;  //                                     ' 2.5 to 10 mg% 



float Vt2;  // 

float Vt3;  // 

float Vt4;  // 

float Vtw1;  //                                 '12.5-20 mg% 

float Vtw2;  // 

float Vtw3;  // 

float Vtw4;  // 

float Vtt1;  //                                '22.5-30 mg% 

float Vtt2;  // 

float Vtt3;  // 

float Vtt4;  // 

float Vft1;  //                                '32.5-40 

float Vft2;  // 

float Vft3;  // 

float Vft4;  // 

float Vfty1;  //                                '50 mg% 

float Vsv1;  //                          '75 mg% 

float Vhd1;  //                               '100 mg% 

// float vTop = 0; 

// float vBottom = 0; 

sensorValue = readValue();      

// read average value from arduino 

vTop = sensorValue + 3; 

vBottom = sensorValue -3; 

//  Serial.print("test program "); 

// Check of Gas sensor voltage from a/d from first state to steady state 

// and detect voltage from gas sensor after checked alcohol 

lcd.clear(); 

lcd.setCursor(0,0); 

lcd.print("Wait...."); 

do 

{  



    for(int ed=1;ed<=10;ed++) 

  { 

    sensorValue = readValue(); 

    Serial.print("sensor = " ); 

    Serial.print(sensorValue);      

    Serial.print("\t  vtop = "); 

    Serial.print(vTop);  

    Serial.print("\t  vBottom = "); 

    Serial.print(vBottom);  

    Serial.print("\t  cx = "); 

    Serial.print(cx);  

    Serial.print("\t  ed = "); 

    Serial.println(ed);  

  } 

  if(sensorValue >= vBottom and sensorValue <= vTop) { 

    if (cx >= check) { 

      Serial.println("Exit"); 

      break; 

    } 

    cx=cx+1; 

  } 

  else  

  { 

    vBottom =sensorValue -2; 

    vTop = sensorValue +2; 

  } 

} 

while(1); 

lcd.clear(); 

lcd.setCursor(0,0); 

lcd.print("Ready.."); 

// Set factor and value for each gas sensor for step from zero to hundred   



Multiply = 1.6;                                        //0.2 less    0.5 more      Factor for each gas sensor  

Stepzero = 5;                                            //   ' zero alcohol 

Stepzero = Stepzero * Multiply; 

//Serial.print("Stepzero = "); 

//Serial.print(Stepzero); 

Stepten = 4;                                           //     ' 2.5-10 mg%  65.31 more 55 less 

Stepten = Stepten * Multiply; 

//Serial.print(" Stepten = "); 

//Serial.print(Stepten); 

Steptwenty = 3;                                       //      '12.5-20 mg%  35 more 30 less 

Steptwenty = Steptwenty * Multiply; 

//Serial.print(" Steptwenty = "); 

//Serial.print(Steptwenty); 

Stepthirty = 2;                                    //         '30.5-30 mg%  13  more    11 less 

Stepthirty = Stepthirty * Multiply; 

//Serial.print(" Stepthirty = "); 

//Serial.print(Stepthirty); 

 

Stepfourty = 1;                                  //           '32.5-40 mg%   7 less 4 more 

Stepfourty = Stepfourty * Multiply; 

//Serial.print(" Stepfourty = "); 

//Serial.print(Stepfourty); 

Stepfifty = 1;                                 //             '50 mg%   25 less 20 more 

Stepfifty = Stepfifty * Multiply; 

//Serial.print(" Stepfifty = "); 

//Serial.print(Stepfifty); 

Stepseventyfive = 7;                         //               '75 mg%  17 less 20 more 

Stepseventyfive = Stepseventyfive * Multiply; 

//Serial.print(" Stepseventyfive = "); 

//Serial.print(Stepseventyfive); 

Stephundred = 6;                             //                       100 mg% 

Stephundred = Stephundred * Multiply; 



//Serial.print(" Stephundred = "); 

//Serial.print(Stephundred); 

// Gas sensor get in to steady state and ready to check flow from breath  

sensorValue = readValue();     //    Check voltage from gas sensor  

Oldval1 = sensorValue; 

 vTop = sensorValue + 15;                                        //   20 less 18 more   high peak of flow  

have an alcohol  

vBottom = sensorValue - 20;                                     //   50 less 18 more   low peak of flow  

zero alcohol  

Oldminbase = sensorValue; 

Oldmaxbase = sensorValue; 

Cnx = 0; 

// Check flow from breath  

do    

{ 

  Vmax = 0;                                                      //   highest voltage from sensor for check 

alcohol concentration 

    sensorValue = readValue();                                    //    Call Adread(0) 

    Oldval1 = sensorValue;                                         //    get sensor value befor flow for be 

the Vmin 

  //  Serial.println("in do loop");                                    // test only 

  if(sensorValue < Minbase){ Minbase = sensorValue; }            //   For check of steady state of 

Gas sensor Min value from gas sensor 

  else Minbase = Oldminbase; 

  if(sensorValue > Maxbase){ Maxbase = sensorValue; }            //   For check of steady state of 

Gas sensor Max value from gas sensor 

  else Maxbase = Oldmaxbase; 

  Oldminbase = Minbase; 

  Oldmaxbase = Maxbase; 

  Cnx = Cnx + 1;                                                  //    Value for counter for check of steady 

state of gas sensor if get to 20 reset to zero and reset   

  if(Cnx >= 20)                                                   //    of high value and low value 



  { 

    Cnx = 0; 

    Oldminbase = sensorValue; 

    Oldmaxbase = sensorValue; 

    Serial.println("reset"); 

  } 

  Serial.print("sensorValue =  ");  

  Serial.print(sensorValue); 

  Serial.print(" Minbase = "); 

  Serial.print(Minbase); 

  Serial.print(" Maxbase = "); 

  Serial.print(Maxbase); 

  Serial.print(" vtop = "); 

  Serial.print(vTop); 

  Serial.print(" vBottom = "); 

  Serial.print(vBottom); 

  Serial.println(" ready "); 

  Vz1 = sensorValue + Stepzero;                    // 0 mg% 

  Vt1 = Vz1 + Stepten;                             // 2.5 to 10 mg% 

  Vt2 = Vt1 + Stepten;                   

  Vt3 = Vt2 + Stepten;   

  Vt4 = Vt3 + Stepten;   

  Vtw1 = Vt4 + Steptwenty;                         // 12.5-20 mg% 

  Vtw2 = Vtw1 + Steptwenty;   

  Vtw3 = Vtw2 + Steptwenty;   

  Vtw4 = Vtw3 + Steptwenty;   

  Vtt1 = Vtw4 + Stepthirty;                        // 22.5-30 mg% 

  Vtt2 = Vtt1 + Stepthirty;   

  Vtt3 = Vtt2 + Stepthirty;   

  Vtt4 = Vtt3 + Stepthirty;   

  Vft1 = Vtt4 + Stepfourty;                        // 32.5-40 

  Vft2 = Vft1 + Stepfourty;   



  Vft3 = Vft2 + Stepfourty;   

  Vft4 = Vft3 + Stepfourty;   

  Vfty1 = Vft4 + Stepfifty;                        // 50 mg% 

  Vsv1 = Vfty1 + Stepseventyfive;                  // 75 mg% 

  Vhd1 = Vsv1 + Stephundred;                       // 100 mg% 

  // Having flow from breath  

  if(sensorValue > vTop || sensorValue < vBottom)  

  { 

    Serial.println("Flow breath"); 

    Vmin = Oldval1;  // Vmin from old sensorValue to calculate in case of Vgas/Vair to be 

concentration or Vgas-Vair  

    cx = 0;          // Counter for breath test  

    Endcx = 50;      // End of counter  

    Distime = 5000;    // Display time 14 sec ?? is it ok ? 

    Y = 0;           /// For calculate of concentration in case of Vgas/Vair ?? 

    // display flow on LCD 

    lcd.clear(); 

    lcd.setCursor(0,0); 

    lcd.print("Flow...."); 

    // Expect that have get an alcohol ?? 

        if(sensorValue >= Vtop) 

    { 

      do 

      { 

        sensorValue = readValue(); 

        Serial.print("Vrs max = "); 

        Serial.print(Vmax); 

        Serial.print("\t sensorValue = "); 

        Serial.print(sensorValue); 

        Serial.print("\t cx = "); 

        Serial.println(cx); 

        // if Vmax >= sensorvalue then add counter of no vmax = sensorvalue  



        if(Vmax>=sensorValue) 

        {  

          cx = cx + 1;  

        } 

        else  

        {  

          Vmax = sensorValue;  

        } 

     //   Show flow display on LCD   

//        lcd.clear(); 

//        lcd.setCursor(0,0); 

//        lcd.print("Flow.   "); 

//        delayMicroseconds(50); 

//        lcd.setCursor(0,0); 

//        lcd.print("Flow..  "); 

//        delayMicroseconds(50); 

//        lcd.setCursor(0,0); 

//        lcd.print("Flow... "); 

//        delayMicroseconds(50); 

//        lcd.setCursor(0,0); 

//        lcd.print("Flow...."); 

//        delayMicroseconds(50); 

        // counter count to end counter then show all value .. 

        if(cx >= Endcx) 

        { 

          Serial.print(""); 

          Serial.print(" Vrs Max  =  "); 

          Serial.print(Vmax); 

          Serial.print("\t Vmin = "); 

          Serial.println(Vmin);             // is it use ?? use in case of vmax/vmin ?? 

          Y = Vmax - Vmin;                  // may not be use ?? 

          Serial.print(" Y = "); 



          Serial.print(Y); 

          Serial.print("\t Vz1 = "); 

          Serial.println(Vz1); 

          Serial.println(" Display of alcohol concentration"); 

              lcd.clear(); 

          lcd.setCursor(1 , 1); 

              if(Vmax < Vz1) 

          { 

            lcd.print("Zero "); 

            Serial.print(" Zero alcohol "); 

            delay(Distime); 

            break; 

          } 

          else 

          { 

            lcd.clear(); 

                if(Vmax>Vhd1) 

            { 

              lcd.print(" 100 mg%"); 

              Serial.println(" 100mg%"); 

            } 

            else if (Vmax>Vsv1 and Vmax<Vhd1){ 

              lcd.print("75 mg%"); 

              Serial.println("75 mg%"); 

            } 

            else if(Vmax >Vfty1 and Vmax<Vsv1){ 

              lcd.print("50 mg%"); 

              Serial.println("50 mg%"); 

            } 

            else if(Vmax>Vft4 and Vmax<Vfty1){ 

              lcd.print("40 mg%"); 

              Serial.println("40 mg%"); 



            }   

            else if(Vmax>Vft3 and Vmax<Vft4){ 

              lcd.print("37.5 mg%"); 

              Serial.println("37.5 mg%"); 

            } 

            else if(Vmax>Vft2 and Vmax<Vft3){ 

              lcd.print("35 mg%"); 

              Serial.println("35 mg%"); 

            } 

            else if(Vmax>Vft1 and Vmax<Vft2){ 

              lcd.print("32.5 mg%"); 

              Serial.println("32.5 mg%"); 

            } 

            else if(Vmax>Vtt4 and Vmax<Vfty1){ 

              lcd.print("30 mg%"); 

              Serial.println("30 mg%"); 

            } 

            else if(Vmax>Vtt3 and Vmax<Vtt4){ 

              lcd.print("27.5 mg%"); 

              Serial.println("27.5 mg%"); 

            } 

            else if(Vmax>Vtt2 and Vmax<Vtt3){ 

              lcd.print("25 mg%"); 

              Serial.println("25 mg%"); 

            } 

            else if(Vmax>Vtt1 and Vmax<Vtt2){ 

              lcd.print("22.5 mg%"); 

              Serial.println("22.5 mg%"); 

            } 

            else if(Vmax>Vtw4 and Vmax<Vtt1) { 

              lcd.print("20 mg%"); 

              Serial.println("20 mg%"); 



            } 

            else if(Vmax>Vtw3 and Vmax<Vtw4){ 

              lcd.print("17.5 mg%"); 

              Serial.println("17.5 mg%"); 

            } 

            else if(Vmax>Vtw2 and Vmax<Vtw3){ 

              lcd.print("15 mg%"); 

              Serial.println("15 mg%"); 

            } 

            else if(Vmax>Vtw1 and Vmax<Vtw2){ 

              lcd.print("12.5 mg%"); 

              Serial.println("12.5 mg%"); 

            } 

            else if(Vmax>Vt4 and Vmax<Vtw1){ 

              lcd.print("10 mg%"); 

              Serial.println("10 mg%"); 

            } 

            else if(Vmax>Vt3 and Vmax<Vt4){ 

              lcd.print("7.5 mg%"); 

              Serial.println("7.5 mg%"); 

            } 

            else if(Vmax>Vt2 and Vmax<Vt3){ 

              lcd.print("5 mg%"); 

              Serial.println("5 mg%"); 

            } 

            else if(Vmax>Vt1 and Vmax<Vt2){ 

              lcd.print("2.5 mg%"); 

              Serial.println("2.5 mg%"); 

            } 

//            delay(Distime); 

            break; 

          } 



        } 

      } 

      while(1); 

      Serial.print(" Vhd1 = "); 

      Serial.print(Vhd1); 

      Serial.print("  Vsv1 = "); 

      Serial.print(Vsv1); 

      Serial.print(" Vfty1 "); 

      Serial.print(Vfty1); 

      Serial.print(" Vft4 "); 

      Serial.print(Vft4); 

      Serial.print(" Vft3 = ");  

      Serial.print(Vft3); 

      Serial.print(" Vft2 = ");  

      Serial.println(Vft2); 

      Serial.print(" Vft1 = "); 

      Serial.print(Vft1); 

      Serial.print(" Vtt4 = "); 

      Serial.print(Vtt4); 

      Serial.print(" Vtt3 = "); 

      Serial.print(Vtt3); 

      Serial.print(" Vtt2 = "); 

      Serial.print(Vtt2); 

      Serial.print(" Vtt1 = "); 

      Serial.print(Vtt1); 

      Serial.print(" Vtw4 = "); 

      Serial.println(Vtw4); 

      Serial.print(" Vtw3 = "); 

      Serial.print(Vtw3); 

      Serial.print(" Vtw2 = "); 

      Serial.print(Vtw2); 

      Serial.print(" Vtw1 = "); 



      Serial.print(Vtw1); 

      Serial.print(" Vt4 = "); 

      Serial.print(Vt4 ); 

      Serial.print(" Vt3 = "); 

      Serial.print(Vt3); 

      Serial.print(" Vt2 = "); 

      Serial.print(Vt2); 

      Serial.print(" Vt1 = ");  

      Serial.println(Vt1); 

      Serial.print(" Vz1  = "); 

      Serial.print(Vz1); 

      Serial.print(" Vrs Max = "); 

      Serial.print(Vmax); 

      Serial.print(" Vmin = "); 

      Serial.print(Vmin); 

      Serial.print(" Minbase = "); 

      Serial.print(Minbase); 

      Serial.print(" Maxbase = "); 

      Serial.println(Maxbase); 

      delay(Distime); 

    } 

    else 

    { 

      for(cx = 0;cx<=2;cx++) 

      { 

        lcd.clear(); 

        lcd.setCursor(0,0); 

        delayMicroseconds(20); 

        lcd.print("Flow...."); 

        delayMicroseconds(20); 

      } 

      lcd.clear(); 



      lcd.setCursor(0,0); 

      lcd.print("Zero"); 

      Serial.print("zero "); 

      Serial.println(sensorValue); 

    } 

    delay(Distime); 

    Oldminbase = sensorValue; 

    Oldmaxbase = sensorValue; 

    Minbase = 0; 

    Maxbase = 0; 

    break; 

  } 

}while(1); 

//  outputValue = sensorValue * 0.004883; 

  // change the analog out value: 

  // map(sensorValue, 0, 1023, 0, 5);   

 

//  analogWrite(analogOutPin, outputValue);            

  // print the results to the serial monitor: 

//  Serial.print("sensor = " );                        

//  Serial.print(sensorValue);       

//  Serial.print("\t output = ");       

} 

float readValue() 

{ 

  float sensorValue=0; 

  float average = 0; 

  for(int n=0;n<800;n++) { 

    sensorValue = analogRead(analogInPin);             

    average = average + sensorValue; 

  } 

  // map it to the range of the analog out: 



  sensorValue = average / 801; 

  return sensorValue; 

} 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ภาคผนวก  ค 

การให้บรกิารทางวชิาการ 

 

วัน/เดือน/ปี หน่วยงานที่ขอความอนุเคราะห์ วัตถุประสงคก์ารใช้เครื่องวัดฯ 

20 พฤศจิกายน 

2555 

ส านักงานป้องกันและบรรเทาสาธารณภัย 

จังหวัดเชยีงใหม่ 

เพื่อใชส้ าหรับการรณรงค์ป้องกันอุบัตเิหตุ

ในช่วงเทศกาลท่องเท่ียวของจังหวัดเชยีงใหม่ 

ระหว่างเดอืนธันวาคม 2555 ถึงเดอืน

มกราคม 2556 

13 มนีาคม 2556 กลุ่มงานจราจรต ารวจภูธรจังหวัดเชยีงใหม่  

อ.เมอืง จ.เชยีงใหม ่

เพื่อน าไปใชต้รวจวัดฯ ตามจุดตรวจต่าง ๆ 

ในช่วงเทศกาลสงกรานต ์ประจ าป ี2556  

28 มนีาคม 2556 ส านักงานป้องกันและบรรเทาสาธารณภัย

จังหวัดเชยีงใหม่ 
 

ผศ.ดร.สุภาพ  ชูพันธ์ ได้รับเชญิเป็นวทิยากร

บรรยายเร่ือง “การใช้เครื่องตรวจวัดระดับ

แอลกอฮอลแ์บบคัดกรองกับการรณรงค์เมา

ไมข่ับ” ในวันท่ี 1 – 2 เมษายน 2556  

ณ โรงแรมเชยีงใหม่     ฮอลิเดยก์าร์เดนท์ 

แอนด์รีสอร์ท อ.เมอืง จ.เชยีงใหม ่

21 มถิุนายน 2556 ส านักงานมหาวทิยาลัย กองพฒันานักศกึษา 

งานกิจกรรมเสริมหลักสูตร 

มหาวทิยาลัยเชยีงใหม่ 

อาจารย์ เจ้าหนา้ที่ และเคร่ืองตรวจวัด

ปริมาณแอลกอฮอลจ์ากลมหายใจ จาก

ห้องปฏบัิตกิารวจิัยฟิสิกสป์ระยุกต ์ เพื่อร่วม

กิจรรมประเพณีน านักศกึษาใหมเ่ดินขึน้ไป

นมัสการพระบรมธาตุดอยสุเทพ ประจ าปี

การศึกษา 2556 ในวันท่ี 6 กรกฎาคม 2556 

8 พฤศจกิายน 

2556 

ห้องปฏบัิตกิารวจิัยฟิสิกสป์ระยุกต ์และศูนย์

วทิยาศาสตร์การแพทยท่ี์ 1 เชยีงใหม ่รว่มกับ

สถาบันวจิัยวทิยาศาสตร์และเทคโนโลย ี

จัดสัมมนาเชิงปฏบัิตกิารเร่ือง “เจ้าหนา้ที่

ตรวจวัดแอลกอฮอลใ์นเลอืดโดยใชเ้ครื่องมือ

วัดแอลกอฮอลจ์ากลมหายใจ” รุ่นท่ี 3 

ระหว่างวันท่ี 28-29 พฤศจิกายน 2556      

ณ โรงแรมโลตัสปางสวนแก้ว อ.เมอืง จ.

เชยีงใหม ่

20 ธันวาคม 2556 กลุ่มงานจราจรต ารวจภูธรจังหวัดเชยีงใหม่  

อ.เมอืง จ.เชยีงใหม ่

ขอความอนุเคราะห์ยืมเครื่องตรวจวัด

ปริมาณแอลกอฮอลจ์ากลมหายใจ จ านวน 4 

เครื่อง พร้อมท้ังเจ้าหนา้ที่ เพื่อน าไปใช้

ตรวจวัดฯ ตามจุดตรวจต่าง ๆ ในช่วง

เทศกาลสง่ท้ายเก่าต้อนรับปีใหม่ ประจ าป ี

2557  

 


